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1 About This User Manual

1.1 The MICROSTAR Rotating Anode Generator

The MICROSTAR is a microfocus rotating anode generator designed to generate a stable X-ray beam 
with high brilliance for accurate X-ray diffraction measurements.

This User Manual discusses the different components of the system and their interaction.

It describes how to use the generator, how to turn it on, how to check and change its settings, and how 
and when to turn it off.

It describes how to verify that the generator is running well and what to do when problems occur. 
Preventive maintenance is also covered.

It also explains how the system deals with different aspects of X-ray safety and how you can use the 
equipment in a safe manner.

We hope you will enjoy using the MICROSTAR.
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1.2 Terms and Conventions Used in this User Manual

Before using this User Manual, it is important to understand the terms and typographical conventions 
used. Certain kinds of formatting in the User Manual’s text are used to identify special kinds of 
information.

1.2.1 Typographical Conventions

Table 1.1 shows typographical conventions used to help you quickly locate and identify information in 
this User Manual.

Table 1.1 – Typographical conventions

1.2.2 Equivalent Terms

Greek and Roman Text

This User Manual uses scientific terminology that may be rendered in Greek text. However, this User 
Manual follows a convention of using Roman text to the greatest extent possible.

Table 1.2 – Greek and Roman text

Convention Usage

boldface
Software interface elements (such as icons, menu items, and but-
tons) to be selected as part of the current procedure.

italics New terms and words requiring emphasis. 

monospace Information read from or entered into a command prompt.

>
Navigation through a hierarchical menu. For example, “Choose 
Start > Programs > Bruker AXS > PILOT” describes navigating 
Windows’ menus from Start to Programs to Bruker AXS to PILOT. 

[square brackets] Keyboard input.

Greek Roman

2θ 2-theta

ω omega

φ phi

χ chi
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1.2.3 Warnings, Cautions, and Notes

This User Manual contains notices that you must observe to ensure your own personal safety, as well 
as to protect the product and connected equipment. These notices are highlighted in the User Manual 
and are marked as follows according to the level of danger.

WARNING!
The word “WARNING” alerts you to an 
immediate or potential hazard that can result in 
death, severe personal injury, or substantial 
property damage.

CAUTION!
The word “CAUTION” alerts you to a potential 
practice or condition that could result in minor 
personal injury or damage to the product or 
property.

NOTE: The word “NOTE” in bold capital letters 
draws your attention to particularly 
important information on the product or 
handling of the product, or to a particular 
part of the product documentation.

1.3 Referenced Documentation

Table 1.3 contains a list of documentation referenced in this User Manual. It is necessary to have this 
additional documentation available as you work with this User Manual. In the documents’ part numbers, 
a variable revision number is indicated by a lowercase letter “x”. Always use the most current revisions 
available.

Table 1.3 – Referenced documentation

Documentation 
Part Number Title

M86-Exx071 MONTEL Graded Multilayer Optics User Manual

M86-Exx079 MICROSTAR Pre-installation Guide
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1.4 X-ray Safety

WARNING!
X-ray equipment produces potentially harmful 
radiation and can be dangerous to anyone in the 
equipment’s vicinity unless safety precautions 
are completely understood and implemented. All 
persons designated to operate or perform 
maintenance on this instrument need to be fully 
trained on the nature of radiation, X-ray 
generating equipment, and radiation safety. All 
users of the X-ray equipment are required to 
accurately monitor their exposure to X-rays by 
proper use of X-ray dosimeters.

For safety issues related to operation and maintenance of your particular X-ray generator, 
diffractometer, and shield enclosure, please refer to the manufacturer’s operation manuals or to your 
Radiation Safety Officer. The user is responsible for compliance with local safety regulations.

1.5 MICROSTAR Help and Technical Support

1.5.1 Technical Information on the Web

The latest technical information concerning the MICROSTAR is available at the following Web address:

http:\\www.nonius.nl\manuals

Additionally, the latest technical updates are available to registered users in the Downloads section of 
the Bruker AXS Web site:

http:\\www.bruker-axs.com



MICROSTAR User Manual About This User Manual

M86-E00086 1 - 5

1.5.2 Technical Support

Users are invited to contact Bruker AXS whenever there are problems or questions related to the 
system. Before contacting Bruker AXS, please:

• Determine the version of the software (if there is a software problem);

• Record any error messages; and

• Determine the conditions and/or steps that recreate the problem.

If the instrument is in North America, contact our North American Service Center:

Table 1.4 – Bruker AXS North American Service Center contact information

If the instrument is outside North America, contact your local Bruker AXS Service Center.

Bruker AXS North American Service Center

Address:

Bruker AXS Inc.

Customer Support

5465 East Cheryl Parkway

Madison, WI 53711-5373

USA

Toll-free telephone: 1 (800) 234-XRAY [9729]

Direct line: 1 (608) 276-3087

Fax: 1 (608) 276-3015

E-mail: Customer.Service@bruker-axs.com

Web: http://www.bruker-axs.com
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2 Safety Considerations 

WARNING!
The MICROSTAR generates X-rays, which can be hazardous if the following safety rules are not 
observed:

This equipment must be operated under the authority of a Radiation Safety Officer, in accordance with 
local regulations.

This equipment must be operated, serviced, and maintained by qualified personnel who are trained on 
the hazards of and precautions against X-ray exposure.

This equipment contains safety circuits which should not be overridden other than with the supplied 
enclosure key. These overrides may only be used for service and maintenance, i.e., X-ray alignment.

The “Open Beam” key should be kept in the custody of the Radiation Safety Officer, not with the 
instrument. This also applies to the X-ray or shutter safety keys, in case a certain X-ray port is not used 
or X-rays should not be used.

Safety circuits must be tested by service personnel or by the Radiation Safety Officer at least every 12 
months as described in this User Manual.

Beam stop blocks must be mounted on unused output ports (see Figure 2.1). These blocks are 
delivered with the generator.

If the MICROSTAR is delivered without an enclosure, the user must guarantee X-ray safety by placing 
the equipment in a safety room.

The radiation enclosure is a shield for only the weak scattered radiation generated with normal X-ray 
diffraction equipment. When using other types of radiation or large samples, the shielding capacity must 
be recalculated and additional shielding might be required.

Take into account the X-ray safety of other installed equipment.
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Figure 2.1 – Beam stop block on port

2.1 Safety Features

2.1.1 Generator Safety Key

The safety keys are located on the front of the MICROSTAR near the X-ray tube and just under the 
tabletop. With the keys removed, the generator is disabled. The “ON” position is horizontal.

2.1.2 Radiation Safety Enclosure

The metal doors and panels are made from 1.25 mm steel plate. The transparent panels are made from 
PVC sheets. For Cu radiation (8 keV), the lead equivalent is 0.25 mm.

2.1.3 Generator Emergency Switch

“Emergency Off” pushbuttons are located on the front and rear panels of the generator. If pressed, they 
immediately isolate the electrical supply to all circuits. The pushbuttons are key-controlled and cannot 
be reset without the key. It is recommended that this key be kept in the custody of an authorized person, 
who can ascertain the nature of the emergency and be satisfied that no harm or damage will result by 
restoring the mains supply (i.e., resetting the pushbutton).

NOTE: For complete isolation of the equipment 
from the mains supply, the external 
isolator must be switched off. The 
external isolator should be fitted on the 
laboratory wall by the user’s building 
services.
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2.1.4 External X-ray ON Lamp

The user can connect an additional fail-safe “X-rays ON” lamp. This lamp should have a filament 12V 
max 250 mA. To have the same functionality as the “X-rays ON” lamp on the X-ray tube, the lamp 
should be connected between pins 4 and 5 of user connector 2 just above the safety interlock panel 
(replace the resistor with the lamp). See Section 2.3.1 for more information on the safety interlock 
panel.

NOTE: If this lamp is located at the entrance of 
the generator room, it might not be 
visible from within the room. 
Consequently, it might not be recognized 
as the cause of a loss of X-ray high 
voltage if the lamp fails.

2.2 Safety Interlocks

The X-ray high voltage cannot be switched on, or is switched off, when: 

• The shutter does not close. 

• The tube cover is not in place. 

• The “X-ray ON” light is defective.

The shutter is closed or does not open when: 

• The shutter open indicators are defective. 

• The radiation enclosure is not closed. 

• The goniometer is not properly positioned in front of the X-ray port. 

• An extra external safety switch is open. 

• The mechanical interlock at the shutter is not open.

2.2.1 Radiation Safety Enclosure

All doors and sliding panels of the radiation safety enclosure are equipped with magnets. In the closed 
position, these magnets actuate the proximity switches and the safety circuit unlocks, making X-rays 
and shutter operation available. 

2.2.2 “X-ray ON” Indicator

The “X-ray ON” indicator consists of illuminated strips on the left, rear and right side of the X-ray tube. 
These indicators are fail-safe. An additional indicator is the red LED on the operator panel.



Safety Considerations MICROSTAR User Manual

2 - 4 M86-E00086

2.2.3 “Shutter Enable” Key

Shutter 1 is the left shutter, as seen toward the tapered end of the X-ray tube. Shutter 3 is on the right 
side. A shutter cannot be opened when its “Shutter Enable” key is removed.

Figure 2.2 – Safety keys panel

2.2.4 “Open Beam” Key

X-ray ports can only be opened when the radiation safety enclosure is closed or when the “Open Beam” 
key is in place. This key should be kept by the Radiation Safety Officer to ensure that work with an open 
radiation safety enclosure is only carried out under qualified supervision.

2.2.5 “Open Beam” Lamp

With the “Open Beam” key overriding the enclosure safety, the “Open Beam” lamp blinks to warn the 
user of the unusual working conditions. The lamp is fail-safe; when the lamp is defective, the shutter 
closes and cannot be opened.

2.2.6 Shutter Bayonet

A mechanical lock inside the shutter can only be released when the bayonet of the collimating device or 
X-ray optics is locked in place with a clockwise movement. Unused X-ray ports should remain covered 
with the safety blocks fitted at the time of delivery of the generator (Figure 2.1).

2.2.7 Tube Cover Safety Switches

The tube covers are essential to safe operation of the system. They provide radiation safety as well as 
protection against injury from the anode drive belt.
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2.3 Enclosure Status and its Effect on X-rays and Shutter Operation

2.3.1 Safety Interlock Panel

The safety interlock panel, located in the High-Voltage trolley, is used to “program” safety actions with 
hardware wire connections.

WARNING!
Any wiring changes may only be done by a 
qualified Bruker AXS Service Representative 
and should be certified by the local Radiation 
Safety Officer. Wiring by unauthorized 
personnel may result in failure of radiation safety 
interlocks.

The shutter and/or HV generator can be set to respond to “Open” or “Closed” status from the radiation 
safety enclosure. The standard wiring of the safety interlock panel is such that all shutters close when 
the enclosure is open. This means that a data collection session is interrupted when doors are opened. 
Data collection restart procedures depend on the program used.

An action Enclosure Open = X-rays OFF can be configured.

Independence between the left and right halves of the enclosure, each controlling a separate shutter, 
can also be configured.

“Open beam” overrides the enclosure door switches.
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2.4 Potential Hazards

2.4.1 Beryllium

The X-ray tube contains windows made of beryllium. In normal use these areas cannot be reached, but 
care must be taken not to touch the window during maintenance. If the beryllium is touched by accident, 
wash thoroughly with soap and water.

Fumes and dust from beryllium metal can be hazardous if inhaled. During use, corrosion of the 
beryllium window may occur, but it should not be cut, machined or otherwise removed. Disposal must 
comply with national and local regulations governing beryllium.

2.4.2 Electrical Safety 

Only qualified technical personnel may access the area under the MICROSTAR table. When a qualified 
technician wants to access these parts, first disconnect all automatic fuses and disconnect the mains 
supply before accessing any interior part of the generator.

2.4.3 Cryogenics

When using a liquid nitrogen cryostat in combination with the MICROSTAR, make sure that refilling of 
dewars can be done safely. Consider the use of automatic refill options if a dewar is located on top of 
the generator table or extra bench. Transport, handling and filling of dewar containers should be done 
by trained personnel aware of the hazards involved. It is strongly advised to read the safety instructions 
that are usually delivered with the dewar containers.

2.4.4 Tube Controller Board Battery

The Tube Controller Board contains a battery that should be regarded as chemical waste according to 
local regulations.

2.4.5 High Voltage Tank Oil

The HV tank contains PCB-free oil; see the Certificate in Chapter 10.



M86-E00086 3 - 1

3 Introduction to the MICROSTAR

3.1 MICROSTAR Rotating Anode Principles of Operation

The MICROSTAR rotating anode X-ray generator consists of a high-voltage supply and an X-ray tube 
with a rotating anode. The hot filament in the cathode cup emits electrons that are accelerated by the 
high-voltage supply. The bias voltage, together with the shape of the focus cup, focuses the electron 
beam into a small focal spot on the anode. The impact of the electrons on the anode generates X-rays 
of an energy/wavelength of ~8 keV / 1.541838 Å (Cu anode).

Only a very small portion of the electrons’ energy is converted into X-rays; the remainder of the energy 
is converted into heat. The rotation of the anode spreads the heat over a large area. This makes it 
possible to use higher loads compared with tubes using stationary anodes. The anode rotates under 
vacuum and is internally cooled with water. A ferrofluidic seal around the anode shaft maintains the 
vacuum while rotating. The high vacuum is maintained by continuous operation of an oil-free roughing 
pump and a turbomolecular pump (TMP).

3.2 MICROSTAR Components

The generator consists of the following:

• X-ray tube cubicle

• High-Voltage Trolley

• Auxiliary Trolley

• Bench or Enclosure

• Operator Panel

• Toolbox

Each component is described in detail in the following Sections.
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3.2.1 X-ray Tube Cubicle

The X-ray tube cubicle, which extends above and below the tabletop, consists of:

• X-ray tube with anode and drive, filament and vacuum system

• Fail-safe “X-ray ON” and “shutter OPEN” lights

• Two shutters:

• Shutter 1 (left-hand facing the tapered end of the X-ray tube) is the default shutter. 

• Shutter 3 is on the other side (the side of the anode’s “water manifold”, i.e., the side where the 
cooling water enters the anode).

• MONTEL or HELIOS focusing optics (optional)

• Vacuum gauge on top of the X-ray tube (gray cap) 

• Safety keys to disable the shutters or override the radiation enclosure safety at the front panel

• Emergency “Power OFF” buttons (front and rear)

• Tube connector panel and TMP controller

• Roughing (pre-vacuum) pump located on the floor to avoid vibration

Figure 3.1 – MICROSTAR X-ray tube cubicle
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3.2.2 High-Voltage Trolley

The high-voltage trolley, located under the tabletop, contains:

• ELCA module, a box with the electronics, and X-ray safety connection panel.

• High-voltage tank with a high-voltage transformer submerged in oil.

• Power inverter mounted on the side of the high-voltage tank.

• Oil pump that pumps the oil through the high-voltage tank and cathode for cooling these parts. The 
heat from the oil is transferred to the water cooling circuit by a heat exchanger on top of the tank.

 

Figure 3.2 – High-voltage trolley

3.2.3 Auxiliary Trolley

The heat from the X-ray tube, the inverter, and the high-voltage tank is removed by demineralized water 
in a closed circuit containing a water circulation pump, a small water vessel, and a heat exchanger. The 
heat exchanger transfers the heat of this secondary cooling circuit to the laboratory cooling water 
supply (the primary circuit). The primary water flow is regulated by an adjustable thermostatic valve 
mounted on the heat exchanger. It stabilizes the temperature in the secondary circuit, avoids 
condensation, and limits the consumption of primary cooling water when less power is used. The 
isolation of the two water circuits makes the generator independent of local water quality and pressure.

Figure 3.3 – Auxiliary trolley
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3.2.4 Bench or Enclosure

• In the smallest bench model, the half-width X-ray tube cubicle is extended by two table cubicles to 
A) house the high-voltage trolley and the auxiliary trolley and B) to support the experimental hard-
ware. Extra cubicles may be added to accommodate larger hardware configurations. The bench 
model generators offer maximum ease of operation for liquid nitrogen cryostats. To ensure X-ray 
safety, such generators must be located in a designated safety room.

• The generator with integral radiation enclosure can be located in a large room with several experi-
ments. The integral radiation enclosure is a shield to prevent access to the radiation area, and to 
protect the operator against background scattering associated with regular X-ray diffraction experi-
ments. It is available with 2½-cubicle and 3½-cubicle generators.

Figure 3.4 – MICROSTAR bench model with PROTEUM R diffractometer and KRYO-FLEX system

Figure 3.5 – MICROSTAR with integral radiation enclosure
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3.2.5 Operator Panel

• The operator panel is connected to the generator by a 4.5 meter cable. The panel must remain con-
nected to the generator at all times. When disconnected, the generator shuts down immediately.

• For bench model generators, the operator is free to place the panel anywhere on the tabletop. The 
default left and right shutter designation can be changed in the generator software to reflect the 
actual side of access after installation in the laboratory.

• For enclosure model generators, the operator panel is located in a special slot in the metal front 
door of the radiation enclosure. During alignment, this door can be folded so that the operator has a 
good view of the experimental hardware as well as of the operator panel itself.

Figure 3.6 – MICROSTAR operator panel
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3.2.6 Toolbox

The toolbox contains special tools for:

• Replacing the filament;

• Replacing the ferrofluidic seal;

• Replacing the water seals;

• Removing the recoil shield from the X-ray tube.

The toolbox also contains replacement parts.

Figure 3.7 – Toolbox
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4 The MICROSTAR Operator Panel

4.1 Operator Panel Overview: Controls and Functions

The standard operation mode for the MICROSTAR is through the Operator Panel, described in this 
Chapter.

Figure 4.1 shows the Operator Panel’s controls and functions:

1. Menu Bar

2. Status window
3. Diagnostic tool
4. Water level indicator
5. Warning window
6. Menu navigation area
7. X-ray area
8. Status LEDs
9. Soft buttons
10. X-ray status window

Figure 4.1 – Operator panel overview
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4.1.1 Display

The large backlit LCD display on the Operator Panel shows all information for the MICROSTAR and lets 
you navigate through its various controls. When the Operator Panel has not been used for some time, 
the display turns dark to conserve power. Using the trackball or pressing a button will restore 
illumination.

4.1.2 Menu Navigation Area

Table 4.1 – Menu navigation area functions

4.1.3 Soft Buttons

These four yellow buttons along the bottom of the display have functions that change depending on the 
current state of the generator. For each soft button, its current function is shown directly above it.

NOTE: The shutter display windows show the 
functions of the yellow shutter buttons 
(their next actions), not their present 
status. The yellow LED next to the 
shutter button shows the present shutter 
status. So the text “OPEN” in the shutter 
display window means that the shutter 
will open when the button is pressed.

Table 4.2 – Soft button functions (from left to right)

Item Function

Trackball Used like a computer mouse for selecting parts of the interface for viewing or editing.

[ENTER] button Confirms a setting or enters the next deeper level of the menu structure.

[CLEAR] button Cancels a setting or enters a higher level of the menu structure.

Item Function

Stdby
With this button, the system can be switched to Standby status (internal water, oil, vacuum and 
anode motor started) or back to Power Up status.

HotKey With this button the most commonly-used display window is opened: Operate > Generator. 

Shutter 1 and 3 soft but-
tons

Opens and closes the shutters. The shutters can also be opened and closed by the goniometer. 
To prevent unauthorized opening of the shutters, the shutters can be disabled by turning off the 
safety key switches under the X-ray tube. 

Red X-RAY soft button
Switches the High Voltage ON and OFF. When pressed in the Power Up status, the system is 
promoted to the Standby status and proceeds automatically to the X-ray ON status.
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Table 4.3 – Standby soft button labels

Table 4.4 – Shutter soft button messages and next actions

4.1.4 Key Switches and Indicator LEDs

Table 4.5 – Key Switches and indicator LEDs

Standby Soft 
Button Function of the button (next action, not the present status) or warning

Shows the status or the intermediate status (from which to which status)

POWER UP Only power on.

STANDBY All equipment running and ready to generate X-rays.

GENERATE Generates X-rays, HV is on. 

#1 - #2

#

To #1 - #2

Going from status #1 to #2

Stable at status #

First fallback to #1, then buildup to #2

sec/10 sec

sec

sec/10

Timeline of transition. sec = seconds, sec/10 = in 10 sec units

command delay time

condition timeout

Message Next Action

Open Press to open the shutter. “PANEL” is the manager and control is by the MICROSTAR software.

Close
Press to close the shutter. “PANEL” is the manager and the control is by the MICROSTAR soft-
ware.

Clear
Press to clear a pending “shutter open” command. This situation occurs when a shutter does not 
open because there is no shutter bayonet fitted. In that case, a shutter must be cleared before it 
can be opened again. “PANEL” is the manager.

Reset
Press to reset the shutter. In Setup > Shutters, the control switches from “hardware” to “software” 
and at the same time the shutter closes. “PANEL” is the manager.

Item Function

POWER LED and Key

When turned from OFF to ON, the display is started and PWRUP is displayed. The LED shows 
whether power is enabled; the key is required to enable the power. The POWER key switch 
makes it possible to prevent unauthorized access to the system. When the generator is in 
Standby or Generate status, this switch is bypassed by the electronics and shutdown by this 
switch is in a controlled way. Immediate shutdown is only possible with the emergency but-
tons at the front and rear of the tabletop.

X-RAY LED and Key
The LED shows whether X-ray generation is enabled; the key switch is used to enable the gen-
eration of X-rays (not to switch on the X-rays). The absence of this key prevents unauthorized 
use of X-rays. 

Shutter 1 LED
Lights when Shutter 1 is open. The key to enable manual control of Shutter 1 is not on the oper-
ator panel; it is located on the generator bench beneath the tabletop.

Shutter 3 LED
Lights when Shutter 1 is open. The key to enable manual control of Shutter 3 not on the opera-
tor panel; it is located on the generator bench beneath the tabletop.
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4.2 Management

Before using the MICROSTAR, it is important to understand the concept of management.

The MICROSTAR has been designed as a node in a fully integrated data collection system. Integration 
is available at all aspects of software, hardware, and radiation safety. Two data collection sessions can 
run simultaneously and independently.

Different parts of the system may be controlled in different ways. For example, X-ray power settings 
may be controlled from the operator panel while Bruker AXS software controls the shutter.

To determine which parts of the system are controlled by the panel or by external software, the system 
is divided into objects (such as X-ray generation, Service mode, and shutter control) which are 
managed either by the panel or have no manager, or are controlled externally over an RS232 
connection (i.e., by Bruker AXS software). Also, hardware (safety) contacts may prevent the execution 
of a command.

A manager may obtain or release control over any object, and any object may be controlled by any 
manager. For example, management settings may be obtained from the operator panel, or released 
from the panel so that external control is allowed.

To obtain or release management for an object:

1. Go to Setup > Management. The Management window will open.

2. Select the object for which you wish to obtain management and press [Enter]. The options release 
and obtain appear next to the selected item.

3. Select obtain. The management for the selected object changes to “PANEL”.

Figure 4.2 – Obtaining management for the ‘Xray’ object

Bruker AXS systems are designed to operate as fully integrated data collection systems. With these 
systems, the operator panel may not be the manager of some objects. Two horizontal lines indicate this. 
Vertically hatched items can only be changed in the Setup menu provided that “PANEL” is the manager.
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Table 4.6 – Default management settings

4.2.1 Super Managers

A hardware jumper determines the hierarchy among the managers.

Examine the top two bits of the middle group of indicators in the Diagnostic Tool to identify the Super 
Manager.

When the two top bits of Super Manager are dark, the Super Manager is RS232. When the two top bits 
of Super Manager are illuminated, the Super Manager is Panel.

More information on Managers and Super Managers is available from your Bruker AXS Service 
Representative.

Figure 4.3 – Location of the Super Manager

Object Default Manager

X-ray Panel

Shutter 1 Panel

Shutter 2 Panel

Service No manager
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4.3 Operate Menu

Figure 4.4 – Operate menu

4.3.1 Generator

The “HotKey” soft button gives direct access to this menu.

The figures in the “limit” column are set in the Setup > tube > limits > user set menu.

The kV and mA values in the “goal” column are the settings for the current experiment.

The hatched bias value is the preferred setting for the current filament. It is set in the Setup > 
Preferences > preferent bias menu.

4.3.2 Recrystallize

Baking the filament (Recrystallization) redistributes the stresses in the filament induced during filament 

winding. Every new filament must be baked. Baking starts when the vacuum is better than 10-6 mbar 
without high voltage. During this process, the filament current is stepped up and stepped down in a 
controlled manner. The duration of the process depends on the quality of the vacuum. The average 
time for baking is 30 minutes. During the baking process, the message “running” is displayed. The 
message “done” at the end of the process remains visible until “running” is displayed again in a new 
baking session.

4.3.3  Conditioning

Conditioning cleans the inside of the X-ray tube by stepping up the tube power. This is required when 
the tube’s vacuum chamber has been exposed to air for a longer time. Conditioning starts when the 

vacuum is lower than 10-6 mbar. Voltage and current are increased stepwise until user limits have been 
reached. The program steps down one step when the vacuum gets worse or when too many trips occur, 
and continues from that level. When conditioning is finished, the kV is at the user limit and the mA is 
reduced to 90% of the user limit. For best performance, set “user limits” 5kV higher than regular use. 
During the conditioning process, the message “running” is displayed. The message “done” at the end of 
the process remains visible until “running” is displayed again in a new conditioning session.

4.3.4 Anode Speed

Choose an anode speed higher then the default calculated anode speed.



MICROSTAR User Manual The MICROSTAR Operator Panel

M86-E00086 4 - 7

4.4 Setup Menu

Figure 4.5 – Setup menu

4.4.1 Shutters

Setup > Shutters > Shutter Control

Select “Hardware” when the shutter is controlled by a goniometer (or other device) connected to the 
GCU connector. With this setting, it is not possible to open or close the shutter from the operator panel.

Bruker AXS goniometers connected at the GCU connector have extensive data collection software with 
a MICROSTAR software plug-in. 

Select “Software” when the shutter is controlled by the MICROSTAR software.

Figure 4.6 – Shutter organization. Dotted areas are in the Setup menu.
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4.4.2 Generator
Modules Used is fixed at Module 1.

4.4.3 Tube
The focus, filament, and target are fixed.

Setup >Tube > Tube Configurations > Limits

The voltage and current figures in the Tube column represent the maximum rating of the power supply. 
The maximum power limit of the anode with a 0.1 × 1 mm hot spot is 2.7 kW. The image of this hot spot 
under a takeoff angle of 6 degrees is a 100 × 100 micron spot. The user can set maximum kV and mA 
values for all new experiments. A common setting of the limits is 45 kV and 60 mA. Be sure that you 
have management (Setup > Management) and that the generator is in status “Power up”.

4.4.4 Management
Assigns managers to objects. For more information on managers and objects, see Section 4.2.

X-ray and Shutters default: “PANEL”. When an external program (i.e., Bruker AXS software and Super 
Manager set to RS232) needs X-ray management, it takes over automatically and “NO MANAGER” or 
“RS232” will show.

Service default: “NO MANAGER”. Do not change this management setting unless asked to do so by a 
Bruker AXS Service Representative.

4.4.5 Preferences

Setup > Preferences > Date/time, Units, Contrast

Selects the format for date/time (European / American) and units (ISO, USA, British).

NOTE: Do not reduce the contrast. The position 
of the cursor will be lost.

Setup > Preferences > Shutter buttons

When the operator accesses the generator from the side with the “X-ray ON” lights, it is more intuitive to 
exchange the assignment of the shutter buttons.

The default left shutter button is assigned to shutter 1. This is the shutter on the left side facing the 
tapered end of the X-ray tube.

The default right shutter button is assigned to shutter 3.

Set up > Preferences > Preferent bias

The optimum bias setting for the MICROSTAR electron gun depends on the position of the filament 
inside the focusing cup and is independent of the kV setting. For a certain filament setup, the optimal 
bias setting can be determined from the image of the double-reflected beam at the exit of the optic 
using a Xyclops.

Figure 4.7 – Xyclops with X-ray safe adapter to optic

Set bias = 0 and align the optic for the highest intensity. Once the alignment is optimal, increase the 
bias stepwise and determine the setting with the highest intensity. Enter this value as the preferent bias.
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4.5 Diagnose Menu

Figure 4.8 – Diagnose menu

4.5.1 Error Logs

At a fault, the generator program stops and continues automatically after 30 seconds. An error is an 
event that temporarily interrupts the generator program and is handled after a confirmation. Three faults 
since power up result in an error. The fault counter is reset after generating an error and not as a 
function of time. Thus, a single fault may be #3 and consequently result in an error. When the generator 
does not respond as expected, check the error log in the Diagnose menu for pending errors and follow 
the instructions on the screen.

0 = the most recent fault. The format of the message is: node number, fault id followed by text. Go back 
in time by entering a higher fault number. Faults have no time stamp.

0 = the most recent error. The format of the message is: node number, error id followed by text. Go back 
in time by entering a higher error number. Errors have a time stamp.

4.5.2 Trips

Displays the number of trips since last power up.

4.5.3 Tube Switches

When the code is 7, all covers are in place. If not 7, check the position of the tapered shield covering the 
cathode, the housing of the shutter open lights, or the top cover.
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4.5.4 Observe

0

Displays the filament current in A. For a given kV, mA, and bias setting, the filament current tends to 
decrease with time. If you keep records about the filament current, you will be able to develop a general 
rule for predicting the end of filament life.

1

Displays the converter frequency in kHz. The frequency decreases with increasing X-ray power. The 
combined information available in Observe 1 and Observe 2 is a tool for the Bruker AXS Service 
Representative to diagnose problems in the power converter.

2

Display Pib in volts. This is a measure of the “ignition” voltage for the semiconductor switching devices 
in the generator’s power converter. The combined information available in Observe 1 and Observe 2 is 
a tool for the Bruker AXS Service Representative to diagnose problems in the power converter.
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4.6 Service Menu

Figure 4.9 – Service menu

This menu accesses the special service commands. Do not enter this menu unless asked to do so by 
Bruker AXS Service. The default for the Service object is “NO MANAGER” so that accidental changes 
are not possible.

4.6.1 Read

Reads contents of memory. By default it will give the data of four successive addresses in hexadecimal 
format, starting with the input address (which will be supplied by Bruker AXS Service).

4.6.2 Modify

No user access. Writes to the memory. 

CAUTION!
Be careful; incorrect writing can put the system 
in a dangerous state, resulting in damage. 

4.6.3 IO

Reads and writes I/O registers.

CAUTION!
Be careful; incorrect writing can put the system 
in a dangerous state, resulting in damage.
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4.6.4 Show Revision

Shows board revisions and software versions. Board revisions are configured with resistors at the 
board in question. Note that the Generator controller and the Tube controller have a submenu with 
board revisions.

4.6.5 Ventilate

This option brings the vacuum chamber to atmospheric pressure (to change the filament). Switch off X-
rays and press the left yellow soft button so that the generator goes to Power Up status. The generator 
must cool down and the turbomolecular pump stops. Air is let in through the valve on the roughing 
(membrane) pump. A microfilter removes particles and moisture from the air so that it is no longer 
necessary to vent the vacuum chamber with nitrogen gas as was recommended with previous 
generators.

4.6.6 What To Toggle

The two or four small bright buttons under “Service” represent two or four user mains options that are 
available with MICROSTAR generators. Buttons 1 and 2 represent the switched internal user mains 
supplies (no longer available since mid-2004). Buttons 3 and 4 represent the user relays that can be 
used to switch external devices. The user relay terminals are located on the backplane just above the 
safety interlock panel. (0.5 A SB fuses) For more information, contact your Bruker AXS Service 
Representative.
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4.7 View Menu

Figure 4.10 – View menu

The pull-down menus under View will be displayed permanently at the rightmost available side of the 
screen by pressing the [Enter] key while the Hand tool is in the top section of that submenu. To remove 
a permanent display press [Cancel] with the Hand tool in the top section.

4.7.1 Primary Status

Shows kV, mA, bias, vacuum and actual anode speed.

4.7.2 Setup Parameters

This menu is the condensed display of the settings in the Setup menu. It displays the RS232 
parameters, the status of the shutters, and the MICROSTAR tube parameters. It also displays 
information on interlocks stopping shutter operation (if any).

4.7.3 Operation Parameters

The status of the mechanical devices as well as the temperatures of the various flows are available.

ON /OFF status is displayed for:

• Water pump;

• Oil pump;

• Vacuum pump;

• Anode motor.
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Temperature is displayed for:

• The oil inside the HV tank;

• The incoming water (from Ext);

• The cold side internal (secondary) circuit;

• The warm side internal (secondary) circuit;

• The water from the anode.

The temperature of all water flows should be less than 40°C. A rough guide for proper cooling is: From 
Ext 20°C; 28°C Int 33°C; Anode out 34°C at 2.7 kW.

Lower water temperatures for “Int” and “Anode out” indicate that a lower consumption of cooling water 
is possible by adjusting the thermostatic valve for less flow. More valve throttle gives a wider range of 
regulation, resulting in better temperature stability in the internal water system of the MICROSTAR.
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4.8 Status Window

Figure 4.11 – Status window

The Status window displays the generator state. The blinking area in the left corner indicates that the 
generator is active.

During a transition phase, the actual state and the new state are displayed. The message TO status1 – 
status2 occurs in case of a recovery from a fault, Status1 being the starting point for the recovery 
procedure.

A thin time line displays the progress of a transition. There are two types of time lines:

----------------- ---displays a delay with a fixed duration (e.g., wait 2 minutes to rev down the TMP before 
venting the X-ray tube).

--- -----------------displays a process with a variable duration (e.g., start conditioning of the X-ray tube 
after the vacuum has reached 10E-6 mbar).

The time scale on the long bar is seconds. On the short bar, the time scale is 10 seconds.
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4.9 Diagnostic Tool

Figure 4.12 – Diagnostic tool

Top left is bit 1.7 (byte 1 bit 7 - most significant bit)

Top right is bit 2.7

Bottom left is bit 5.0

Bottom right is bit 6.0 (byte 6 bit 0 – least significant bit)

For an explanation of the bits, select them in an empty screen.
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4.10 Water Level Indicator

Figure 4.13 – Water level indicator

When this section is dark, the water vessel should be filled. Use demineralized water.
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4.11 MICROSTAR / Warning Window

Figure 4.14 – MICROSTAR / Warning window

In this window, the name MICROSTAR is displayed. In case of a fault or error, the error message is 
displayed. At a fault, the generator program stops and continues automatically after 30 seconds.
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4.11.1 Faults and Errors

An error is an event that temporarily interrupts the generator program and is handled after a 
confirmation. Three faults result in an error. The fault counter is reset after generating an error and not 
as a function of time. Thus, a single fault may be #3 and consequently result in an error. When the 
generator does not respond as expected, check the error log at the Diagnose menu for pending errors 
and follow the instructions on the screen.

An example of a fault is: you start X-rays but the X-ray enable key is in “off” position. Turn the key and 
press the [Clear] button. Depending on management the generator program continues immediately or 
after 30 seconds.

4.11.2 In Case of a Fault

In case of a fault, press the [Clear] button to continue the generator program.

When “PANEL” is not the manager of “X-ray”, the message is removed from the display but the 
generator program continues after 30 seconds.

When “PANEL” is the manager of “X-ray”, the message is removed from the display and the generator 
program continues immediately.

4.11.3 In Case of an Error

In case of an error, press the [Clear] button to handle the error and start the generator program:

When “PANEL” is not the manager of “X-ray”, the message is removed from the display but the program 
will not start until the manager of “X-ray” confirms the error. A user at the operator panel can obtain the 
management of “X-ray” (Setup > Management) and consult the Diagnose > Error Log menu.

When “PANEL” is the manager of “X-ray”, the message is removed from the display, the error is 
handled, and the generator program starts.
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4.12 X-ray Status Window

Figure 4.15 – X-ray status window

Table 4.7 – X-ray status window messages

Message Status

When X-rays are off, possible displays are:

Start Generate Press the red button to start X-rays.

noXray manager First obtain “X-ray” management.

other manager Another “X-ray” manager is active.

When X-rays are on, possible displays are:

Stop Generating Press the red button to shut down X-rays.

Kill Generating Press the red button to grab X-ray management and shut down X-rays.

Generating busy: “PANEL” is not the manager of X-ray and the Super Manager is RS232.
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4.13 Shutter Display Windows

Figure 4.16 – Shutter display window

NOTE: The information in this window has two 
different formats:
[* text] indicating the status, where * is 
shutter 1 or 3, or [text *] indicating the 
next action, where * is shutter 1 or 3.
The messages displayed depend on the 
status of the generator.
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The statuses are:

Figure 4.17 – Shutter status messages

The “next actions” are:

Table 4.8 – Shutter next actions

Message Status

* Gone
The shutter cannot be opened as the “shutter present switch” inside the shutter is not closed or 
the wiring is disconnected. Ask your Bruker AXS Service Representative for advice. This 
message is only available at X-ray ON.

* LockX

The shutter cannot be opened as the shutter interlock on the safety interlock panel is not closed. 
See the description of the safety interlock panel (Section 2.3.1). When Bruker AXS goniometers 
are installed, safety switches may be fitted to verify the goniometer position in front of the X-ray 
tube and/or primary collimator and beam stop. Check these switches.

* LockA
The shutter cannot be opened as the “all shutter” interlock on the safety interlock panel is not 
closed. Check enclosure doors.

* Key
The shutter cannot be opened. Check the shutter key at the safety panel near the X-ray tube. 
This message is only available at X-ray ON.

* Remote

The shutter cannot be opened as the safety interlock on an external device connected to a 
GCU connector is not closed. The safety feature at the GCU connector is available when a hard-
ware strap is made (during initial installation of the external device). This message is only avail-
able at X-ray ON.

* Error Unspecified shutter error, e.g., shutter does not close or closes too slowly.

* Hardware
The shutter is closed. An external device connected to the GCU connector controls the shutter. 
“PANEL” is manager of the shutter, but you should make sure that the process on the external 
device has finished before operating the shutter from the operator panel.

 *Clos’d: The shutter is closed and is not managed by “PANEL”.

* Stuck
The shutter is not closed and not managed by “PANEL”, and there is no command to open the 
shutter. Hardware problem.

* Set
The shutter is not open and not managed by “PANEL”, and there is a command to open the shut-
ter. Typically a mechanical cause, e.g., no shutter bayonet, defective rotary shutter solenoid.

* Open The shutter is open but is not managed by “PANEL”.

Message Next Action

Open * Press to open the shutter. “PANEL” is the manager and control is by the MICROSTAR software.

Close * Press to close the shutter. “PANEL” is the manager and control is by the MICROSTAR software.

Clear *
Press to clear a pending “shutter open” command. This situation occurs when a shutter does not 
open because there is no shutter bayonet fitted. In that case, the shutter must be cleared before it 
can be opened again. “PANEL” is the manager.

Reset *
Press to reset the shutter. In Setup > Shutters, the control switches from “hardware” to “software” 
and at the same time the shutter closes. “PANEL” is the manager.
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5 Starting and Stopping the 
MICROSTAR

5.1 Starting the MICROSTAR

NOTE: To familiarize yourself with the operator 
panel controls, please read Chapter 4.

NOTE: The information below refers to the 
operation mode as “standalone 
generator” where “Panel” is the manager 
over the objects X-ray, shutter1 and 
shutter 3. (see Setup > Management).

NOTE: At the end of this Chapter, the difference 
in instructions for control of the 
MICROSTAR by a Bruker AXS data 
collection program will be given.

1. First, check whether the laboratory cooling water supply is available. The MICROSTAR uses 
temperature sensors rather than flow sensors, so a lack of flow will not be noticed. As long as the 
temperature in the internal water circuit remains below 40°C, the generator will operate without 
external cooling water. However, once at power, the generator will switch off quickly without 
external water cooling.

2. Turn the Power key to the “ON” position. The display window will show Stdby.

3. Turn the X-ray key to the “ON” position to enable X-rays to be generated.

4. Press the “Stand by” soft button. The pumps and the anode motor will start and the Status Window 
will change from “Power up” to “Standby”. The X-ray control window shows “Start generate”.

5. Press the “HotKey” button and select the kV and mA values for the current experiment. We advise 
45 kV, 60 mA.

6. If the tube has been exposed to atmospheric pressure and/or the filament is new, select Operate > 
Recrystallize and/or Operate > Conditioning. Otherwise, skip this step.

7. Press the red X-ray button. The status window shows “Stand by – Generate” and, once the set kV 
and mA values have been reached, the status window shows “Generating”. The X-ray control 
window shows the next action of the red button: “Stop Generating”.

8. Wait 30 minutes to one hour to stabilize the beam before starting a data collection.

NOTE: While the MICROSTAR is generating, 
press the yellow shutter soft button to 
open the shutter.
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5.1.1 Restarting After a Power Loss

1. Proceed as above, but verify the optic setting as the vacuum in the optic was lost.

5.2 Idling and Stopping the MICROSTAR

At the end of a data collection, it is best to turn down the power but keep X-rays ON. In this way there is 
a minimum variation of the stress on the filament.

NOTE: The longest filament life is obtained with 
relatively high kV and low mA, avoiding 
extra heating of the filament due to the 
fallback of electrons. We recommend 45 
kV, 5 mA as standby settings.

With X-rays ON, there are 3 ways to stop the generator in a controlled way:

• When pressing the red button, X-rays are stopped and the generator falls back to the “standby” 
state so that it is immediately available to generate X-rays again.

• When pressing the left yellow button, the generator falls back from X-ray ON to Power up. All pumps 
and motors are turned off. The vacuum will gradually deteriorate but the vacuum chamber is not 
vented.

• When turning off the Power key switch the generator falls back from X-ray ON to Power OFF.
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5.3 Operating the MICROSTAR as part of a Bruker AXS System

When the MICROSTAR is part of a Bruker AXS data collection system, the manager of the objects “X-
ray” and “Shutter” is RS232 and shutter control must be set to hardware (see Setup > Management 
and Setup > Shutters > Shutter Control). The generator settings kV, mA, and X-ray ON/OFF are done 
on the data collection terminal. The shutter is controlled by the data collection program.

When the shutter closes because the radiation enclosure is opened, data collection stops. When the 
doors are closed again, data collection is resumed automatically and repeats the interrupted scan. The 
data collection program monitors the “X-ray stable” signal from the MICROSTAR during data collection. 
After a trip (internal discharge in the vacuum chamber), data collection will stop for 30 seconds and 
then repeat the interrupted scan.

NOTE: Although the Panel is not the manager 
of “X-ray” and “Shutter”, it is still possible 
to switch off X-rays or close the shutter 
from the operator panel for emergency 
reasons. Of course, this might interrupt a 
running data collection.

NOTE: When the MICROSTAR is put back into 
operation after a long period it is advised 
to run Conditioning (Operate > 
Conditioning) before starting a data 
collection.
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6 MICROSTAR Maintenance

6.1 Scope and Disclaimer

The mechanical maintenance described in this Chapter is intended for users who have attended a 
maintenance course. It comprises only a part of the required periodic maintenance.

The skill of an experienced Bruker AXS Service Representative is required for items related to high 
power, delicate mechanics, and vacuum. When problems arise with these items, please discuss the 
situation with Bruker AXS Service before attempting any repair or maintenance.

NOTE: Bruker AXS cannot give free technical 
support for work outside what is 
described in this User Manual, and is not 
responsible for work done by users.

6.2 Preventive Maintenance

For the longest operational lifespan of the MICROSTAR, yearly preventive maintenance is strongly 
advised.

WARNING!
Some of the generator’s moving parts have a 
limited lifespan and can cause extensive 
damage to the MICROSTAR if not replaced in 
time.

6.2.1 Bruker AXS Preventative Maintenance Visits

A yearly preventative maintenance by Bruker AXS Service consists of: 

• Replacement of the ferrofluidic seal, filament, TMP lubrication, carbon brush in the water manifold, 
and V-belt. 

• Polishing and cleaning the focus cup, recoil shield, anode, water manifold, and vacuum gauge. 

• Optional: refurbishment of the anode, or replacement by a new or refurbished anode. 

• Check of safety devices. 

• Several other checks. 
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6.2.2 Customer-performed Preventative Maintenance

Some items mentioned in this Chapter can be done by the user after a maintenance course, but there 
are limitations: 

• The anode can only be polished, but sometimes grinding is needed. Incorrect grinding can cause 
pollution to be pressed into the anode material, causing a bad vacuum by heavy outgassing. Also, 
mineral deposits inside the anode should be removed, otherwise the cooling becomes less effi-
cient. This results in overheating of the anode, which is shown by a bad vacuum caused by heavy 
outgassing. This refurbishment can only be done at the factory. 

• The recoil shield can only be cleaned in situ, because of the risk of vacuum leaks as a result of 
incorrect remounting. 

• See the Parts List at the end of this User Manual for the parts required on a yearly basis.

6.3 Filament Replacement

Filaments are supplied in a set together with mounting rod screws, clamp segments, Allen wrenches, 
and cathode O-rings. 

6.3.1 General Information

When mounting a new filament: 

• Clean parts should be handled with lint-free, powder-free gloves. 

• Filaments should be handled with plastic tweezers only. 

• All parts around the focus should be mounted by hand, never using a tool other than the locking 
key, and never using force. When removal cannot be done by hand, put some acetone in the screw-
thread. If it is still not possible to remove or mount the focus cup assembly, return the parts to 
Bruker AXS. 

Cleaning the cathode is occasionally necessary and should only be done by a Bruker AXS Service 
Representative. Ceramic parts should only be cleaned with a diamond file. Metal parts should be 
cleaned first using Scotchbrite 07447 or 07448, and then rinsed and brushed with acetone. It is 
important that no residues are left behind, since any residues will pollute the vacuum.

6.3.2 Preparing to Change the Filament

When a filament breaks, the operator panel will show a message and the generator will go into 
Standby status. 

1. Go to status Power UP. 

2. If the filament broke at high power, wait at least thirty minutes for it to cool down.

3. Unscrew (a couple of turns) the two screws at the bottom of the tapered tube cover and remove the 
screw at the top near the vacuum gauge. Remove cover.

4. Unscrew the small Allen screw that locks the HV cable nut. Remove the HV connector.

5. Discharge cable by touching the 3 cable pins against the blank metal parts of the X-ray tube.
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6. Confirm that the filament is broken by measuring the resistance in the HV connector with (long) 
measuring probes between the COMMON and FILAMENT contacts (Figure 6.1). An intact filament 
has a low resistance.

7. Select Service > Ventilate at the operator panel to ventilate the X-ray tube.

8. Switch off the generator completely.  

9. Remove the cathode. Take care not to change the distance S (Figure 6.1).

10. Measure the distance D (Figure 6.1).

Figure 6.1 – Removing the filament

11. Loosen the four Screws A, without removing them. 

12. Unscrew the height adjustment nut while lifting off the entire focus cup assembly. A rocking motion 
may be necessary to remove the assembly. 

13. Remove two uppermost screws B, which hold the filament in its mounting rods. Remove the 
filament. 

14. From the filament set, place two new Screws B using an Allen wrench. 
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15. Place the new filament with the leads in the grooves. The spacing of the filament leads has a 
tolerance, so sometimes one wire must be pushed gently into the groove. 

16. Place the filament height setting jig and, using plastic tweezers, gently adjust the position of the 
filament such that the filament sits between the marks and against the top of the jig. Gently fasten 
the two screws B. This is the most important step for a good alignment! 

17. Place the entire assembly over the filament on the cathode, taking care that the cup does not 
touch the filament. Screw the assembly into place. 

18. Check the position of the filament (Figure 6.2).

Figure 6.2 – Correct position of filament

19. If the focus cup needs to be re-aligned to the filament, loosen the locking ring (with the locking ring 
key), align the focus cup, and tighten the locking ring again. 

20. Place the shorting key in the cathode. 

21. Carefully place the depth gauge on the focus cup, avoiding any damage to the filament. Adjust the 
height of the filament with the height adjustment nut until the LED in the depth gauge is just on. 

22. Tighten the four screws A so that the filament sits in the center of the cup. Do not use force on the 
screws as this can deform the mounting tube, causing problems in removing it from the ceramic 
disk. 

NOTE: Turn the height adjustment nut slightly 
up, so that it is not tight but free. The four 
screws A hold the assembly in place. 

23. Once the filament is at operating temperature, it can be (slightly) deformed. Usually this poses no 
problem. The deformation is due to a mismatch of the pitch of the filament leads and the slots in 
the cathode rods or by incorrect tightening of the screws B.

24. Re-check proper tightening of all screws.

Figure 6.3 – Filament deformation and tightening of screws
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6.3.3 Cathode Mounting

Figure 6.4 – Cathode mounting

NOTE: Skip steps 1-4 when the fixed distance 
cathode base is present.

1. Re-measure D, X, and Y (if not noted during the last filament change). Keep a log of the distances 
for future replacements: Y will never change, and X will only change after an anode replacement. 
Distance AC should be 8.5 mm for the 100-micron MICROSTAR focus.

2. If D is within ± 0.2 mm of the old value, remount the cathode without changing the setting of S.

3. If D is outside ± 0.2 mm, calculate the new distance S = (AC + D + Y) - X.

4. Adjust the threaded collars and adjust this distance with the slide-rule (delivered with the 
generator) before the cathode is placed against it. The distance S should be as good as possible, 
but at least with an accuracy of 0.2 mm.

5. Mount the cathode carefully. The filament must be visually horizontal. When the oil outlet is on top, 
the filament is about horizontal.

WARNING!
If the filament is accidentally mounted vertically 
(i.e., in the plane of the rotation) the anode will 
be overheated locally and the anode will be 
destroyed.

6. Remove the shorting key. 

7. Refit the HV cable. Tighten the nut and the small locking screw.
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8. Refit the tapered tube cover and select Diagnose > Tube switches. The value 7 indicates that all 
covers are placed correctly.

Figure 6.5 – Tools

6.3.4 Recrystallization

1. Start the generator and select Operate > Recrystallize. Allow some time for the process to finish. 

6.3.5 Preferent Bias

1. Redo the Preferent Bias procedure described in Section 4.4.5.
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6.4 Anode Water Seal Replacement

The water seal in the water manifold needs to be replaced at least every year.

6.4.1 Disassembly

1. Switch off the generator completely.

2. Remove the anode grounding brush, which is situated at the bottom of the water manifold.

3. Remove the water manifold supply section by unscrewing two screws. The tubes are removed.

Figure 6.6 – Water manifold parts

4. Unscrew the inner stem retaining nut with the counterface seal key. This is a left-handed screw, so 
turn clockwise to unscrew.

5. Remove the water manifold return section by unscrewing two screws.

6. Remove the water manifold water seal section by unscrewing three screws.

7. The water seal can be taken out by pushing.

6.4.2 Assembly

1. Remount the water seal section and fasten the screws loosely. 

2. Place the centring cylinder in place of the seal in the water seal section and fasten the screws. 
Align also by rotating the section till the sloping part is parallel to the part underneath.

Figure 6.7 – Fitting the water seal

3. Sparingly lubricate the outside O-ring of the seal with vacuum grease (delivered with the 
generator), but no grease should come out on the flat sides.

4. Place the guidance cone and mount the seal by hand. Don’t use tools.

5. Remount the return section. Align it with the section underneath so that the bottom, top, and 
sloping sides are exactly aligned.
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6. Fit the inner stem retainer nut (left-handed) with a torque of 8 Nm. The torque wrench is delivered 
with the generator.

7. With a new anode, check if the anode rotates smoothly. If not, then dismount and place a shim on 
the anode shaft (between anode and ferrofluidic seal, two are delivered with new anodes).

8. Remount the supply section. Align it with the section underneath so that the bottom, top, and 
sloping sides are exactly aligned.

9. Remount the connector to the temperature measuring device and remount the anode grounding 
brush.

6.5 Shutter Replacement

1. Switch off the generator completely. 

2. Remove all covers. 

3. Remove the shutter with the three screws. 

4. Disconnect the wires. The connector is in the half cubicle, under the X-ray tube. The colors and 
connection numbers are indicated nearby on a label. When removing the cable, attach a wire or 
string with which the new shutter cable can more easily be drawn through the tubes. 

5. Mount in the reverse way. 

6. After mounting, check the shutter present (safety) switches in the control panel: View > Setup 
parameters. When it shows “not fitted”, shift the shutter a little bit before tightening the screw, until 
the message disappears.

6.6 Anode Drive Belt Replacement 

The anode drive belt should be replaced every year.

1. Remove the water manifold as explained in Section 6.4. 

2. Remove the old belt. 

3. Clean the pulleys with acetone. 

4. Mount a new belt. 

5. Adjust the tension of the V-belt by shifting the anode motor in the two slots. The tension is correct 
when the belt can be pushed down about one centimeter when applying a force of 0.5 kg near the 
motor. At insufficient tension, the belt will vibrate. Take care: with high tension the bearing of the 
motor and anode will wear out. 

6. Remount the water manifold as explained in Section 6.4.
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6.7 Anode Replacement 

6.7.1 General

This replacement should only be attempted by skilled personnel, such as Bruker AXS Service 
Representatives or users who have attended a maintenance course.

Clean parts which are in vacuum should only be handled with lint-free, non-powdered gloves.

6.7.2 Rotor Plate Remounting

1. Go to the status POWER UP.

2. After high power, wait at least thirty minutes to cool down.

3. Go to Service > Ventilate to ventilate the tube. Because this action only opens the valve for 15 
seconds, this should be done several times (approx. 10 times) until the vacuum is gone.

4. Switch off the generator completely.

5. Remove the anode speed sensor holder at the motor pulley.

6. Take the drive belt from the motor pulley.

7. Disconnect the water hoses from the water manifold and rotor plate.

8. Unscrew the three large screws fixing the rotor plate to the head, while holding the assembly in 
position.

9. Withdraw the assembly. First move it slightly in the direction of the motor, then pull it straight out. 
The anode should not get scratched on the way out. Place the assembly with the flat side of the 
anode on a clean flat surface.

6.7.3 Anode Disassembly

1. Place the anode in the anode retaining fixture. 

2. Remove the water manifold as described in Section 6.4.1.

Figure 6.8 – Anode mounting tools

3. Unscrew the counter face seal with the counter face seal key and a 12 mm torque wrench.
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Figure 6.9 – Pulley removal

4. Take off the pulley. 

5. Pull out the rotor plate. Some force may be required here to overcome the friction of the O-ring in 
the bearing sleeve. Never use tools. If you don’t succeed, contact Bruker AXS Service.

6.7.4 Anode Cleaning

Cleaning of the anode has limited value (see Section 6.2). When desired, the anode may be cleaned 
with acetone and lint-free cloth. Extreme pollution can be removed with Scotchbrite 07447 or 07448. A 
convenient way is to polish the surface while it rotates in a lathe. Proper care should be taken to avoid 
scratches or damage to the shaft while it is clamped. After polishing, the anode must be washed with 
acetone.

6.7.5 Anode Remounting

1. Place the anode in its retaining fixture. 

2. Carefully put the rotor plate assembly over the shaft, without an O-ring in the bearing sleeve, just to 
check if it fits. The anode should fit smoothly without any friction. Do not use force if there is 
friction. 

3. Sparingly lubricate a new O-ring (part number 2132162) with vacuum grease, and put it into the 
groove in the bearing sleeve. Also, put a tiny bit of vacuum grease on the anode shaft. 

4. Place the rotor plate assembly over the anode shaft while making sure that this shaft is absolutely 
straight in the bearing sleeve. There should be no force required until the O-ring is reached. A 
gentle tap on top of the rotor plate should be sufficient to overcome the friction, after which the 
rotor plate can be lowered to its proper position. 

5. Insert sparingly lubricated O-rings (part numbers 2132162 and 2132163) into the pulley and bring 
the pulley into position on the anode shaft. Take care not to damage the O-rings while doing this. 

6. Mount the counter face seal and tighten it with a torque of 18 Nm. 

7. Remount the water manifold as described in Section 6.4.2.

6.7.6 Rotor Plate Mounting

1. Clean all parts with Scotchbrite 07447 or 07448 and clean afterwards with acetone. Leave 
sufficient time to dry. 

2. Put a slightly lubricated new O-ring (part number 2132963) into the head. 

3. Carefully insert the rotor plate assembly into the head. 

4. Shift it a little in the direction of the cathode to the right position. Check that the O-ring is still 
properly positioned. 

5. Fasten the rotor plate with its three screws.

6. Reattach the anode drive belt as in Section 6.6.
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6.8 Ferrofluidic Seal Replacement

1. Remove the rotor plate assembly and anode as described in Section 6.7. 

2. Remove the bearing plate and all shims from the rotor plate. 

Figure 6.10 – Clearing the ferrofluidic seal

3. Place the puller in a vertical position on a flat table and put the empty cartridge and the rotor plate 
over the shaft. The empty cartridge is delivered with a new system and should be kept for returning 
the ferrofluidic seal. 

Figure 6.11 – Ferrofluidic seal puller

4. Place the large bush and the pin.

5. Rotate the puller (hold the rotor plate by hand). The cartridge will be pushed out of the rotor plate 
into the container. At the end, the pin should be placed in a lower hole to pull out the ferrofluidic 
seal completely.

6. Check the rotor plate for burrs or damage. Make sure that the vacuum side is clean.

7. Put a tiny bit of vacuum grease on the inner surface of the rotor plate, but not in the water 
channels.

8. Take the cover from the new cartridge. There are two types of cartridges:
8.1. With a protruding plug at the bottom. Push with this plug the ferrofluidic seal out a bit.

8.2. Without the plug. During mounting, first place thin distance holders, like coins under the sides 
of the cartridge (take care: not under the ferrofluidic seal). Pull out the ferrofluidic seal a little 
bit. Remove the coins and proceed.
The protruding part of the ferrofluidic seal is needed as a guide into the bore of the rotor plate.

9. Place the rotor plate and the new cartridge reverse on the puller and mount the small bush and 
pin.

10. If needed, pull out the ferrofluidic seal a bit as described above and remove the coins.
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11. Pull the ferrofluidic seal completely into the rotor plate. At the end, the pin should be placed in a 
lower hole to pull in the ferrofluidic seal completely.

12. Remove the rotor plate from the puller and check that the cartridge is pulled in completely. There 
should be no space left between the bottom of the rotor plate and the first seal body.

13. Place the rotor plate back on the puller.

CAUTION!
Never place the rotor plate on the table, 
otherwise there is a risk of damaging the 
ferrofluidic seal.

14. Measure the protrusion D of the cartridge from the face of the rotor plate, using a Vernier caliper 
and determine the number of shims required. If D is less than 0.10 mm and not zero then no shims 
are necessary. If D is more than 0.10 mm then one shim has to be placed. If D is more than 0.20 
mm then two shims, and so on. Place the (clean) shims.

15. Place the bearing plate and clamp ring. Center the bearing plate on the clamp ring and tighten the 
bearing plate with three screws.

16. Remount the anode and rotor plate assembly as described in Section 6.7.

17. A ferrofluidic seal should be “run in” at standby speed for one hour.
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6.9 Safety Tests

6.9.1 Shutter Safety

1. Switch off the X-ray high voltage.

2. Open the shutter. Check the “Shutter Open” lamps.

3. Check that the shutter will not open under these unsafe conditions:
3.1. Radiation enclosure open (and Open beam key switch disabled).

3.2. Radiation enclosure safety (Open beam) overridden with the key-switch under the table, 
Beam-open lamp removed and enclosure open.

4. Check the flashing “Open Beam” lamp when the radiation enclosure safety (Open beam) is 
overridden by the key-switch.

6.9.2 X-ray High Voltage Safety 

1. Switch on the high voltage to minimum: 20 kV, 5 mA.

2. Check the “X-ray ON” lamps. 

3. Check that the high voltage shuts off when:
3.1. The tapered front cover is removed. 

3.2. The shutter lights cover is removed. 

3.3. The main shutter is manually opened with a small screw in the center of the shutter aperture. 

WARNING!
Take care not to come into the vicinity of the 
primary beam!
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7 MICROSTAR Troubleshooting

7.1 Startup Errors

7.1.1 Generator Does Not Go to The Power Up Status (But No Error is Shown)

1. If the display does not light:

1.1. Check the red safety push buttons on the side of the cabinet (below the table). They can be 
pressed by accident. Release them with the keys.

1.2. Check the manual fuse (elca) on the electronic cabinet.

1.3. Check the main power (installation fuses or switches)

1.4. Open the electronic cabinet and inspect the two power supplies on the left. Both should have 
a green LED lit. If not, then this power supply is defective.

2. If the display works, but the Power on LED (yellow) is not on:
2.1. Go to standby and see what error message appears.

7.1.2 Generator Does Not Go to The Standby Status (But No Error is Shown)

1. Check the status on the display:

1.1. “Power up”: check in Setup > Management that the manager of “X-ray” is set to “Panel”.

1.2. “Standby - Power up”: the generator was going back to the Power Up status (for instance, 
after an error) and will first finish this sequence before going to the Standby status again.

2. Check in the menu View > Operating parameters that the Oil circuit is “ready”. If not, contact 
Bruker AXS Service.

3. Shutter problem.
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7.2 Low Vacuum

A normal vacuum is:

• 1x10-7 to 9x10-7 without power.

• below 9x10-7 with medium power (for instance 3 kW)

A bad vacuum is mostly caused by leakage, which should be resolved by a Bruker AXS Service 
Representative. Please check:

1. Check that the pre-vacuum pump is really running.

2. Switch to standby (low 600 rpm anode speed and no HV). When vacuum is bad, it is probably a 
leaking O-ring. Because it is difficult to find which O-ring, we advise a maintenance visit. In most 
cases it is the cathode O-ring. Take into account that with every remounting of the cathode a new 
O-ring must be fitted.

3. Adjust the anode speed to 5500 (will show 6000) but with HV off. If the vacuum is too low or not 
stable, the ferrofluidic seal is probably worn out. Take into account that the ferrofluidic seal has a 
limited lifespan of about a year.

4. Switch on the HV, first with lower power, then with high power.
4.1. If a 13-16 (Vacuum alarm) occurs directly after HV on (before HV or mA are rising), then 

check the error history with the service program (to see if there are other errors preceding the 
vacuum alarm).

4.2. If the vacuum decreases greatly with high power then:

a. The tube is polluted.

b. Mineral deposits inside the anode have not been removed for some time. This can 
only be done in the factory during refurbishment.

c. Incorrect procedure of cleaning the surface of the anode, causing outgassing from 
pollution pressed into the anode material.

d. Be sure that you have not changed anything in the cooling water circuit (e.g., wrong 
connection of the cooling tubes).
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7.3 Shutter Does Not Open

(sometimes error 13-08)

1. If the HV remains on, it is a problem with safety or setup:

2. Look at the shutter status in the control panel: View > Setup parameters.
2.1. “Absent”: The “shutter present” switch is not activated. Switch off the X-rays. Ask an experi-

enced mechanical engineer to loosen the shutter (screws) a bit and rotate the shutter housing 
till the “Absent” sign disappears. If this does not help, the shutter has to be returned for repair.

2.2. “Key-switch”: The shutter key switch under the table is disabled. Switch to the enabled posi-
tion (key horizontal).

2.3. “Interlock”: One of the shutter safeties is active:

The door is not closed. Test by switching the “Open beam” key switch under the table, so the 
“Open beam” lamp flashes. If the shutter can now be opened, the enclosure was not closed 
(detected by safety switches in the doors).

When using with Open beam: the “Open beam” lamp should flash. If not, replace the lamp.
Check the goniometer safeties: Kappa CCD, MACH3, or CAD4.

Check if the goniometer detecting switch (hover safety) is in the correct position (if present). 
This magnet/reed switch is mounted close to the X-ray port /monochromator to detect that the 
goniometer is placed in front of the X-ray port. 

2.4. “Error”: An 13-08 error has occurred. 

Check the shutter setup (also when generating X-rays) in the control panel: Shutter opened from 
goniometer Shutter opened from Control panel

Setup > Management shutters are set to “No management” or “RS232”, shutters are set to “panel”.

Setup > Shutters shutters are set to “GCU enabled”, shutters are set to “GCU disabled”

When normally opened by the goniometer (setting on a board) and HV = on, then the shutter must also 
be opened by the goniometer (for the goniometer shutter safeties)

Check that the X-ray port bayonet coupling (if present) is properly positioned. The mechanical safety 
slot inside the shutter can prevent opening.

In the service program, State bit = 1 and after HV on:

Sequence error: 

Open the shutter by hand or: 

Press the shutter open switch two times very quickly.

Now the State bit = 0 and the shutter will work till next power down/up. This error can occur now and 
then is caused by timing error/bug 

State bit = 1 directly after HV on

Check ST23/24 on the Tube controller board: When the new shutter PALs are mounted (TUBE1CA, 
TUBE1CB, TUBE3CA and TUBE3CB, PCN24) and when Nonius equipment is used then ST23/24 
must be open.
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7.4 Error Codes on the Operator Panel

Selection of errors from the operator panel. For other error messages, contact Bruker AXS Service.

12-40 NOT STANDBY FOR HV

Not ready to generate HV (Generator is not in Standby status).

12-41 kV NOT RECHARGED

Action taken, for instance HV ON, when the kV wasn’t fully discharged after the HV OFF. Wait some 
seconds and repeat.

12-43 BAD VACUUM RECRYST

Starting recrystallization when the vacuum is too low. Wait till the vacuum is high and the 
recrystallization will continue automatically.

12-44 AUTOMATIC FUSE AUX (Microstar)

The automatic fuse of the auxiliary unit (with pumps etc.) is off

13-01 LOOSE HT CABLE END

The “HT cable present” connector on the tube is not placed.

13-02 LOOSE TUBE COVERS

The white tube cover with the red lights is not in place, detected by a reed switch with magnet in the 
cover.

13-03 LOOSE TUBE SHIELD

The connector of the tube shield is not placed, indicating that the metal tube around the cathode of the 
X-ray tube is not in place.

13-07 TEMP ALARM COOLWATER

The temperature of the cooling water at the secondary output of the heat exchanger is too high. Check 
the input water flow and the temperature. The temperature is shown in View > Operating parameters.

After restoring the cooling, the temperature of the secondary water can still be too high preventing the 
water pump to start. It has to cool down on its own, which can take some time. It is possible to start the 
water pump with a service command. Use this command only when needed, because incorrect use can 
start other parts without safety.

Get service management.

Go to Service > IO and choose Write and Tube controller.

Write (indifferent data) to address FF6B. The water pump will start.

Be careful: the pump is now running without any safety, so after cooling down start again from power 
down.

13-08 SHUTTER FAIL

One of the shutters doesn’t open, doesn’t close, or the safety shutter fitted switch is not activated.
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If the error is permanent, one can track it by reading the status in Service > Read > Tube-cntr:

Address FF5A, data: the last digit should be F ($...F). If not, the “shutter present” switch is not pressed. 
You could try to loosen the three screws of the shutter a little bit and shift the shutter until the last digit is 
F again. If you don’t succeed the shutter must be readjusted by Bruker AXS Service.

If the last digit = E, then the error is in shutter 1.

If the last digit = B, then the error is in shutter 3.

Address FF50 and FF54, data: the first digit should be 4 ($4..). If it is E or 6, the shutter is not fully 
closed. You can close it with the screw in the center of the shutter rotation.

If it is address FF50 = then the error is in shutter 1.

If it is address FF54 = then the error is in shutter 3.

After restoring the error, sometimes the generator must be powered down/up to reset the error 
message.

13-0B ANODE DRIVE OVERRUN (FR591) or ANODE DRIVE CURRENT (MICROSTAR)

Start again and go in smaller steps to the kV/mA power.

13-12 LEVEL ALARM WATER

Cooling water level in the vessel is too low. Refill the vessel with demineralized water (Observe 
electrical safety precautions!)

13-13 FLOW ALARM TUBE

No water flow through the anode. Causes:

Water pump doesn’t run.

Check if the water hoses for kinks.

During start after the water was filled: not enough water yet. Ask Bruker AXS Service for instructions to 
start the water pump and leave it running for at least 15 minutes, until the water flow doesn't switch off. 
Start again in the normal way.

13-16 VACUUM ALARM

Check the low vacuum list.

13-43, 56 TURBO SPEED FAILS or TURBO PUMP TIMED OUT

Turbopump speed too low or turbopump did not reach the right speed after 4 minutes.

After several years of operating, the turbopump bearings can be are worn. A Bruker AXS Service 
Representative can check this by inspecting the grease cartridge. It is advised to refurbish the 
turbopump, which is not expensive. One can choose to do this through the local Balzers/Pfeiffer 
representative.

14-03 TEMP ALARM HEATSINK1

The heat sink is located in the power module, situated to the left of the HV tank. This is cooled by two 
thin brown tubes.
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Check that the primary water pressure is above 2 bar. This error is often a symptom of insufficient water 
pressure.

Check the input and output water cooling connections on the power module. Both must be cold. When 
the output is warm, you can try to disconnect and clean them by flowing water through the power 
module in two directions.

14-0A LEVEL ALARM HV TANK

The oil level in the HV tank is too low. Check if there is oil leakage on the floor.

14-0D XRAYS DISABLED

Trying to generate X-rays while the “X-ray” key switch is in the disabled position.

14-0E XRAYS LAMP FAILS

Both red “X-ray ON” lamps are defective.

14-42 FILAMENT SET FAILS

This can be caused by:

Low tube current. The tube current should not be too low: at least 10 mA.

Broken filament. When the generator is switched off and on, it should come with a broken filament 
message.

Many trips rapidly after each other.

Sudden manual change from bias high to low.

14-4B GATE DRIVE FAULT

For a 9 kW generator: Go to Setup > Generator and check if it is set up for module 1. If not, change to 
that.

Check if the manual fuse 9kW1 (module 1) is on. If it switches off again, there is a technical problem 
and Bruker AXS Service must be contacted.

The check circuit can be temporary switched off through the Control panel: Service > Modify > Write: 
Gen-ctrl, RAM, address 1B7B, data 07. First, get service management. Do this only after instructed by 
Bruker AXS Service. If this does not help, the electronics are defective.

14-4C FILAMENT CHECK FAILS

Filament current too low; most probably a broken filament.

14-55 AUTO

The Stotz switch of a 9 kW module is switched off. Switch it on again.

14-56 SHORT

A short circuit between the filament and the bias cup. The filament has to be replaced. If it is caused by 
a rotation of the filament, then check with the next filament that it does not change during fastening (see 
Section 6.3).
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7.5 Internal Error: Input Buffer Overrun

This error is a communication error on the digital bus and is typically caused by an electrical 
disturbance. This can be:

Strong HV trips. In time the generator head gets polluted and the trips get more severe, until they 
disturb the electronics. A maintenance visit is then necessary.

7.6 Communication Problem with Computer or Goniometer

Check if the RS232 communication parameters are right with: Service > Read > node: Main-ctl, 
address $81C6 and $81CA

$81C6  -  $  0     not used (hand shake)

$81C7  -  $  4     1200 bd, for 9600 bd: $ 25

$81C8  -  $B0     1200 bd, for 9600 bd: $ 80

$81C9  -  $  8     databits

$81CA  -  $  1     stopbit 

$81CB  -  $  0     parity = none

If the values above are not set up (all different values), the software will automatically choose 9600 
baud.

Don’t look at the view menu, because the RS232 parameters shown are not correct.

7.7 No mA

Open the tube and check that the filament does not touch the focus cup.

7.8 Service Program

A service program is available which reads the internal registers and values for troubleshooting the 
system.

Retrieve the self-extractable program and start the file, which will install the program.

Connect the PC with a RS232 null modem cable with the RS232 connector.
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8 Declaration of Conformity
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9 Certificate of Radiation Safety
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10 Certificate of PCB-Free HV Tank Oil
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11 Spare Parts List

11.1 Cathode and Focus

Table 11.1 – Cathode and Focus

Part Number Description

0592390 Cathode

0592841 Fine focus filament set (3x) including mounting parts

0191197 Filament clamp segment

0592016 Focus cup

0571701 Fine focus mounting assembly, excluding focus cup

0191191 Filament mounting sleeve

0191192 Height adjusting nut for fine focus

0191193 Locking ring for a fine focus cup

0571105 Mounting tube for fine focus

6050029 Set screws for Cup to mounting tube, M3×3 Qty. 4
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11.2 Anode, Rotor Plate, and Drive

Table 11.2 – Anode, Rotor Plate, and Drive

Part Number Description

Cu anode

0592372 Cu-anode High-Brilliance Anode (HBA) for MICROSTAR

6077018 Shim in anode, 25 × 18 × 0.1 mm

0592201 Complete rotor plate assembly + HBA Cu anode

0592355 Ferrofluidic seal for MICROSTAR

2985158 Shim 61.0 × 0.1 on ferrofluidic seal

2134044 Water seal in water manifold (Furon seal) 

0168374 Counterface water seal, on the anode axis

0592302 Anode motor unit

2033114 V-belt (1120 mm)

0571351 Pulley which guides the V-belt (for replacement two are needed)

0168375 Pulley on the anode shaft

0164656 Labyrinth ring under the anode drive pulley

2692023 Brush: anode grounding in water manifold
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11.3 Vacuum

Table 11.3 – Vacuum

11.4 HV circuit

Table 11.4 – HV Circuit

11.5 Shutter

Table 11.5 – Shutter

Part Number Description

2995813 Diaphragm roughing pump, Pfeiffer MD 4T or MVP 055-3

2995815
Diaphragm set for 2995813, PK050117-T (4 double-diaphragms; 
O-rings: 4 large, 8 small; 6 seals FPM, 2 seals PTFE for in/output)

2995810
Turbo-drag pump Pfeiffer TMH 261, used with diaphragm prevac-
uum pump

2995811 Power supply TPS200

2140987 Clamp

2140988 Splinter shield

2140073 Grease cartridge

2995540 Vacuum gauge PKR251. Pfeiffer

2136100 Air filter in ventilate valve

Part Number Description

2570189 HV cable, 5.6m (standard, with two large connectors)

4010071 Silicone oil + washer for the HV connectors

0591320 HV tank

4080003 Transformer oil, Shell Diala D

Part Number Description

0591114 Shutter 

0591114R Shutter, refurbished

0164227 Shutter dummy bayonet (closed beam)

0163090 Shutter unlocking bayonet (open beam)
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11.6 Cooling

Table 11.6 – Cooling

11.7 Power

Table 11.7 – Power

Part Number Description

2140054
Water pump + motor 50 Hz. Grundfos CRi 1-5 (can also be used 
for former CNR2-40)

2140055
Water pump + motor 60 Hz. Grundfos CRi 1-5 (can also be used 
for former CNR2-40)

2140050 Motor 50 Hz for pump 2140052

2140051 Motor 60 Hz for pump 2140052

2140052 Water pump without motor, see 2140050/1 Grundfos CRi 1-5

2657056 Control valve FJVA in primary water, Danfos

2995907 Flow switch (water or oil). Need no adjustment

2136102 Flow switch, type VHS 20M (Aux. trolley)

2657311 Temperature (clixon) switch for 9kW module heatsink (56•C)

2140063 Oil pump for both 50/60 Hz

2682038 Fan, all except in enclosure and bench

0591126 Fan for enclosure and bench

Part Number Description

2625087 Power relay in 9 kW module, including power contacts

2625237 Main relay (in 9 kW module) top-contact block for sense signals

2681054
Power supply +24V +12V (upper supply, HSU100-21, made from 
2x 12V) [front plate should be shortened or exchanged with older 
supply]

2681055
Power supply +5V +15V (lower supply, HSU100-31) [front plate 
should be shortened or exchanged with older supply]
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11.8 Units

Table 11.8 – Units

11.9 Boards

Table 11.9 – Boards

Part Number Description

0591400T Complete 9 kW HV-ELCA unit

Part Number Description

0591610T Main controller board. For HBA anode order also EPROM...

0592611T Tube controller board for MICROSTAR

0592612T Generator controller board for MICROSTAR

0591619T Anode drive board for new Papst motor

0591615T Filament & bias board

0591616T Shutter board

0591617T Trafo board

0591620T Measurement board

0591621T Multiplier board

0591622T Resistor board

0591623T  Filament-rectifier board

0591630T Bridge board

0591631T Power interface board
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11.10 Electronic Parts

Table 11.10 – Electronic Parts

11.11 Lamps

Table 11.11 – Lamps

Part Number Description

2518920
RAM with battery on the Main controller board 0591610T, IC 21 
(for clock)

2561930 Thyristor (3x in 9 kW module)

2620796 Relay with LED in Power module (behind manual fuses)

2655172 Fuse 500 mA slow

Part Number Description

2603235 Open beam lamp 12V
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11.12 O-rings

Table 11.12 – O-rings

Part Number Description

2132162 2x O-ring 17.10 × 1.60, for anode pulley and shaft

2132163 O-ring 19.10 × 1.60, for pulley face seal

2132252 O-ring 28 × 5.3

2132254 O-ring 29.10 × 1.60

2132255 O-ring 22.10 × 1.60

2132310 O-ring 31.42 × 2.62, for water manifold, HPA

2132429 O-ring 37.77 × 2.62, for water manifold

2132431 O-ring 47.00 × 5.34, for cathode

2132528 O-ring 56.82 × 2.62, between measuring flange and head

2132529 O-ring 58.42 × 2.62, for recoil shield

2132634 O-ring 66.35 × 2.62, for recoil shield front

2132635 O-ring 69.57 × 1.78

2132721 O-ring 78.97 × 3.53

2132963 O-ring 94.97 × 1.78, between rotor plate and head

2132965 O-ring 107.20 × 5.34, between flange and turbo pump

4000014 High vacuum grease, for O-rings
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11.13 Tools

Table 11.13 – Tools

11.14 Maintenance Sets

Table 11.14 – Maintenance Sets

Part Number Description

0163629 Tool for disconnecting the HV connector

0164091 Recoil shield adapter disk

0164092 Puller extender disk for recoil shield

0164118 Locking ring key for focus

0164124 Water seal press for water manifold

0164656 Ferrofluidic seal clamp ring

0168385 Counterface seal key

0168124 Cathode shorting key

0168383 Water seal guidance cone

0168384 Water seal centering cylinder

0591844 Anode retaining fixture

0571326 Pin hole

0571328 Pin hole puller

0571329 Seal puller

0571346 Filament height setting jig, for fine focus

0571451 Depth gauge 0.1 × 1

2995720 Torque wrench 8-54 Nm

2995725 12 mm part for Torque wrench

0591404 Xyclops CCD video camera, including box with parts

Part Number Description

1592100
Set for yearly maintenance, 
MICROSTAR / MICROSTAR-H
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11.15 Other

Table 11.15 – Other

Part Number Description

2601475 Enclosure safety override key switch

2547089 Track ball

2590334 Faston receptacle 2.8 × 0.8

0591826  RS232 extension cable Elca module (no null modem)

2995190 Mirror vacuum pump membrane

2625000 Magnet switch for enclosure and covers
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